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CHAPTER 1: INTRODUCTION 

 

The European Commission's Online Submission Service (hereinafter referred to as 'Submission 
Service') is designed to automate the documentation submission process for organisations and 
individuals interested in submitting proposals for funding under various EC program initiatives. 

 

Document Scope and Structure 

 

The purpose of the Proposal Submission Guide is to describe how beneficiaries can prepare and 
submit a Proposal using the Submission system. The document also provides additional reference 
information about the Service, as well as troubleshooting and configuration advice.  

 

The following sections of information are available: 

 CHAPTER 1: INTRODUCTION provides information and links to the relevant resources, a high 
level description of what you will need to prepare prior to your submission, a list of user 
actions, and contact and support information. 

 CHAPTER 2: SUBMITTING YOUR PROPOSAL THROUGH THE ONLINE SUBMISSION 
SYSTEM provides step-by-step guidance on how to submit your information using the 
Commission's online system. 

 CHAPTER 3: REFERENCE GUIDE TO SCREENS, ROLES & ACCESS TO USER ACTIONS 
describes the screens and the basic tasks you can perform using the system, as well as a 
description of the user roles in the system. 

 APPENDIX A: TROUBLESHOOTING, COMPATIBILITY & CONFIGURATION ISSUES 
provides general information on common issues and solutions relating to system compatibility, 
configuration, and troubleshooting. 

 APPENDIX B: REGISTRATION provides instructions on how to register a new account with 
the European Commission Authentication Service (ECAS). 

 APPENDIX C: CALLS WITH SPECIFIC CONTACT ROLES contains examples and guidelines 
related to rare cases with calls that require specific contact roles in the proposal submission 
process. 

 The GLOSSARY section contains descriptions of the most common specialised terms that you 
might come upon in this document. 
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The Proposal Submission Process 

Learning about the EC Grant Proposal Process 

It is very important that you familiarize yourself with the overall research and innovation grant process 
by first consulting the HOW TO PARTICIPATE page on the Participant Portal. There you will find a 
wealth of information including the Horizon 2020 Online Manual, numerous Reference Documents, the 
Beneficiary Register, a Financial Capacity Self-Check, as well as important information on the 
participation of Micro, Small and Medium Enterprises (SMEs). Please read through all these resources 
prior to starting your Submission process. 

Proposal Submission Preparatory Checklist 

In preparation for your online application submission process, you must go through the following 
steps: 

1. Decide on the funding opportunity that you want to apply for. Funding Opportunities are 
categorised as Work Programmes, Calls, Topics and Types of Actions. Programmes are listed 
under the Horizon 2020 title.  

2. Select your Partners. Most calls require a consortium of three organisations.  Relevant 
information can be found on the Participant Portal. 

3. Register as a user in ECAS (the European Commission Authentication Service). For 
instructions also see Appendix B at the end of this document.   

4. Your organisation and your Partner organisations must register in the Beneficiary Register 
through the Participant Portal and receive a Participant Identification Code (PIC). Additional 
information is available in the Beneficiary Register Manual. 

Quick Steps to the Online Submission Process 

The following basic user actions are involved in the online submission process. Refer to Chapter 1 for 
the detailed step-by-step procedures. 

1. Login to the Participant Portal and Select your Topic 
2. Create Draft of your proposal 
3. Manage Your Related Parties 
4. Edit Proposal draft form, download templates, complete all required information, upload files 

and submit your proposal 
5. Following submission, you can re-edit, download or withdraw your proposal (except for 

continuously open calls where you can only download the proposal) 
6. Invite Partners to the process 

Accessing Your Draft and Submitted Proposals 

You can access your saved proposal drafts as well as your submitted proposals at any time, from the 
My Proposals page in the Participant Portal (you must be logged in). Alternatively, you can access 

your proposals from the My Organisations page in the Participant Portal using the  action 
button for the organisation. 

Contact and Support 

For questions on any aspect of grant applications and the EU Research Framework Programmes, 
including beneficiary registration and data updates, please refer to the Horizon 2020 Helpdesk. 

http://ec.europa.eu/research/participants/portal/desktop/en/funding/index.html
http://ec.europa.eu/research/participants/docs/h2020-funding-guide/index_en.htm
http://ec.europa.eu/research/participants/portal/desktop/en/funding/reference_docs.html
http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
http://ec.europa.eu/research/participants/portal/desktop/en/organisations/lfv.html
http://ec.europa.eu/research/participants/portal/desktop/en/funding/sme_participation.html
http://ec.europa.eu/research/participants/portal/desktop/en/opportunities/h2020/index.html
http://ec.europa.eu/research/participants/docs/h2020-funding-guide/grants/applying-for-funding/find-partners_en.htm
https://webgate.ec.europa.eu/cas/eim/external/register.cgi
http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
http://ec.europa.eu/research/participants/portal/desktop/en/home.html
http://ec.europa.eu/research/participants/data/support/manual/urf.pdf
https://ec.europa.eu/research/participants/portal/desktop/en/proposals/index.html
https://ec.europa.eu/research/participants/portal/desktop/en/organisations/index.html
http://ec.europa.eu/research/index.cfm?pg=enquiries
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For any IT-related problems that you might experience with the Submission system, please contact 
the Research IT Helpdesk.  

Once you have started the submission process, additional contact information is available at the 
bottom of the submission page. 

CHAPTER 2: SUBMITTING YOUR PROPOSAL THROUGH THE 

ONLINE SUBMISSION SERVICE WIZARD 

Once you have your ECAS username and password, your PIC and your Partners' PICs, you can start 
the submission process by logging in to the Participant Portal and using the European Commission's 
online Submission Service Wizard. 

 

 

USER ACTION #1: Log In & Select Your Topic 

To log in, perform the following steps: 

http://ec.europa.eu/research/participants/api/contact/index.html
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1. Go to the Participant 
Portal: http://ec.europa.eu/research/participants/portal/desktop/en/home.html

 

 

2. Click the Login button. You will be prompted to authenticate through the ECAS login screen: 

http://ec.europa.eu/research/participants/portal/desktop/en/home.html
http://ec.europa.eu/research/participants/portal/desktop/en/home.html
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3. In the ECAS login screen enter your ECAS user name and password, then click the Login 
button. 
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To select a call topic, perform the following steps: 

1. Once logged in to the Participant Portal, you will need to select the Call Topic for which you will 
submit your proposal.  

 

Note: A Programme comprises many Calls and each Call can have one or more Topics. A 
submitted proposal is always for one Topic.) 
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2. Click on Funding Opportunities. 

  
3. EITHER, Click on a Call category. You can filter the Call results list in the following ways: 

To sort the results by type, select from the respective options at the top of the page.The 
example shown in the image below is for Horizon 2020. 
To sort the results by status, select from the respective options below that (Forthcoming, Open 
or Closed). 
To search by a key word, type a relevant word in the Filter a call field to search by, and click 
the Filter button. 

 
You can also sort your results by (Planned) Opening Date, Deadline, Call title, and Call 
identifier.  
 

  
The corresponding calls will appear at the bottom of the page. 

 
Click the call to open it, then click the appropriate topic. 
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Or 
 
Click Search Topics to search directly for a specific topic. You can filter your results by 
selecting the programme or the status. You can also enter keywords in the Find a topic field 
and click the Search button. You can also sort your results by (Planned) Opening Date, 
Deadline, Call title, and Call identifier. 

 

 
The corresponding topics will appear at the bottom of the page. 
 

 

 
In both cases, the Call description page appears.  
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4. Click the Submission Service tab, then click the START SUBMISSION button. 

 
 
  

USER ACTION #2: Create Draft of your Proposal 

You are now in the Online Submission Service wizard.  

 

Carry out the following steps: 

1. Enter your organisation's PIC. If you do not have the full PIC number, you can search by 
name or select from a previously associated organisation.  
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2. Entering the PIC will automatically populate the name field and highlight the address, as 
shown in the picture below. 

 
 
 
Note: In case the entered PIC is incorrect, the following error message appears: 
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3. Select your role: Main contact or Contact person: 
 

 
 
You would typically select the top-level role (Main contact for most calls) for the Proposal 
Coordinator organisation during the initial proposal draft creation. If you select the Contact 
person role (or another role if the call uses specific roles – see below), make sure to add 
the top-level role (Main contact) in the next steps before you submit your proposal. 
 
Note: For more information about roles in the system, see section Roles: Proposal 
Coordinator, Partner, Contact Person in this document . 
 
IMPORTANT: Most calls use the standard Main contact and Contact person roles for the 
Proposal Coordinator organisation. However, some calls (e.g. H2020-MSCA-IF-2014 and 
ERC-2014) may require more specific roles, such as Principal Investigator, Main Host 
Institution Contact,  Researcher, Supervisor, Applicant, etc. Calls of this type are pre-
configured accordingly and their proposal submission forms contain special sections to 
address the specific roles and the respective data as needed. Likewise, the Proposal 
Submission Wizard for these calls will display the respective role options, as configured for 
each call. For more information about calls with special roles, see Appendix C: Calls with 
Specific Contact Roles at the end of this document. 
 

4. Fill in the Acronym field. 
 

5. Fill in the Summary field. 
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6. Click . 

 

 
 
 
Note: When you add a partner organisation with a validated PIC to your proposal, this 
action will be communicated to the LEAR automatically. Whenever a LEAR is informed 
about the involvement of their organization, you as the person who added the organisation 
will see the warning message shown in the figure below: 
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7. You will be presented with the following Disclaimer – click  to accept it and 

proceed, or  to decline it and cancel the proposal submission. 
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8. The following message confirms that your draft proposal has been created. You will also 
receive a confirmation email. 
 

 
 

9. Click  to proceed to the next step.  
 
To postpone this action for a later time and return to your list of proposals in the Participant 

Portal, click . 
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USER ACTION #3: Manage Your Related Parties and/or Edit Contact Details 

In this step you can add, remove, and manage additional partner organisations and their 
contact persons (roles). You can also edit the contact person's details of the main 
organisation. 
 
 

1. Go to Step 4 - Manage your Related Parties, as shown in the picture below: 
 

 
 

2. The following message presents the Consortium Eligibility requirements for the minimum 
number of participants. 
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Note: Before you can invite a Partner, your partner must have a PIC (see the Submission 
Preparatory Checklist section above).  
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3. Click   as shown in the picture below:  
 

 

 

4. Enter your Partner organisation's name and click .  
This will give you a list of organisations matching the term in the search field: Make 
sure to select an organisation with a valid PIC from the list of search results. You can 
recognise validated organisations by the 'validated' status message displayed below 
the organisation's details. 
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5. Select your Partner organisation and click the  button. This will make the Add 
Contact window appear. 
 

6. Click on the question mark in the window read the rules  
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7. Select the appropriate project role of the Partner Contact: 
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8. Select the access rights that you want to grant to your Partner contact. Only the person 
assigned the Main Contact role and having full access rights can submit an application. 
 

  
 
Note: Once you grant full access rights to a Contact person, he/she will not be allowed to 
alter their own access level to 'read-only' – this can only be done by you in your role of the 
Proposal Coordinator (or by another user with full access rights). 
 

9. Fill in the fields and click OK 
 

  
 
Note: If the Contact person does not have an ECAS account yet, the system will use the e-
mail provided for that contact to send them an invitation and grant ECAS access. 
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10. You will see the second contact appear in the Partner section  

 
Repeat the same steps for the remaining Partner organisations. 
 
 

Note:  The Proposal Submission System checks automatically if the first and last 
names of the contact match the name details of the user currently logged in the 
active ECAS session. Adding a contact with a name that does not match the user 
name registered in ECAS will give you a warning message 
 
The mismatching name details will then be circled in red colour. If you receive such 
a message (as shown in the figure below), review your first and last names as they 
do not match the information registered along with the email address in your ECAS 
account. In case you wish to change your registered name in the Proposal 
Submission System, you will have to make these changes in your ECAS account. 
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You can perform the following actions for an existing partner organisation using the buttons described 
below: 

 

 

1.  Delete participant 

Click this button to delete any participant except the coordinator. 

2.  Partner information 

Click this button to see more information about the partner company. 

3.  Add contact 

Click this button to add a new contact to an existing partner company. 

4.  Edit existing contact 

Click this button to edit an existing contact by clicking the pencil icon (5). 
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5.  Delete existing contact 

Click this button to delete an existing contact. 

Note: You cannot delete a contact when this user is currently logged in. 

6.  Contact information 

Click this button to see more information about the company contact. The 

name field will expand to show the email address and phone number of the 

contact. 

7.   
Click this button to replace the existing organisation (PIC). Coordinator 
contacts with full access rights can now change the coordinator organisation 
or the partner organisation. Clicking the Change Organisation button will 
open the PIC search pop-up window, where the user can search for, and 
select, another organisation. 
 

8.   
Click this button to contact the LEAR of an organisation. 
 

 

 

 
 

 

 

 

 

 

 

 

 

11.  Once you have completed this task, click on  and then click on  to go to 

User action #4.  
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Note: At this point, the system will automatically generate emails to all the Partner contacts. The 
emails include all relevant information and links to access the proposal. The Access rights granted to 
each Partner contact will determine the level of access that the contact will have. 

 
 
 
 
 
 

Improved notification system for deleted contacts 

When a contact is deleted from the list of contacts from an organisation, their access rights to a 
proposal will be revoked. As a result, this person will no longer be able to view or edit the proposal. If 
you can no longer view or edit proposals that you were previously able to work on then it is very likely 
that your profile was deleted from the list of contacts resulting in a revocation of access rights. 

If this happens, you will be informed by email that your access rights to a particular proposal have 
been revoked. 
 

 

 

 
 
 
 

Promoting a Partner Organisation to Coordinator Status 

 

Current coordinators (with full access rights) can now swap roles with a partner organisation.  Any 

partner organisation that has provided details of a main contact can be promoted to the coordinator 
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role. Please note that swapping roles will not be possible if the call requires a fellow coordinating 

organisation. 

Step-by-step procedure: 

1. Create a draft proposal with coordinator and a partner organisation. 

2. Ensure that partner organisation has a main contact.  

 

 

3. Drag and drop partner organisation and replace it with the current coordinator organisation. 
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4. Confirm the changes to both roles by clicking the  button.  
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The former partner organisation has now been promoted to coordinator status. The contact persons of 
both organisations will also receive e-mails informing them that a transfer of access rights has taken 
place (as shown in the two figures below). 
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Error Message For Profit Organisations when Searching for an Organisation - 
Solution 

For a number of calls within the Horizon 2020 Program, organisations need to be validated as 'for profit'. 

Otherwise, the error message below will be displayed and will block the organisation from submitting a 

proposal for certain calls: 

 

            

Please follow this procedure step by step in order to have your organisation appear as a For Profit one and 

be allowed further through the submission process: 

1. Go to the Participant Portal and click on the Modify Organisation action button to modify the existing 

information and select the program as shown below: 
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2. Click the Organisation data link. The Organisation data section is displayed. 

3. Select the for-profit option button, then click the Submit changes button. 

 

 

4. Click the Legal Status link. The Legal Status section is displayed. 
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5. Select the for-profit option button, then click the Submit changes button. 

 

 

6. To make additional changes to the organisation data, click the New Request button: 
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USER ACTION #4: Edit and Complete Proposal Draft Form, Download Templates and 

Complete all Required Information, Upload Files, Validate and Submit your Proposal 

This step is the core of the submission process. Click on  or, to access a previously saved draft 
proposal form, go to the MY AREA > My Proposal(s) page in the Participant Portal (you must be 

logged in) and click  in the ACTIONS column for the respective proposal, as shown in the picture 
below: 
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The following picture shows Step 5 of the Online Submission Wizard: 
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The Action Buttons of the Wizard 

The action buttons shown in the picture above are described in the table below 

Button Description 

 

 

Click to open the PDF form that you want to complete. 

 

 

Click to view in detail the list of all system and user actions. This function enables: 

 the Proposal Coordinator to verify that partners have updated their forms 

 Partners to verify that the coordinator has submitted the proposal in a timely 
fashion. 
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Button Description 

 

 

 

Click to open or download and save the proposal locally on your computer. 

 

 

Click this button to download templates before the draft proposal is created. Click to 
download the latest proposal requirements package, in a readily editable (RTF) 
template.  

Once completed, you must convert the proposal template into a PDF file.  

  

 
Click to upload the respective file. 

The upload process for the complete set of files can take between a few seconds 
and a few minutes, depending on the speed of your Internet connection. When the 
upload is complete, the system displays a confirmation message and creates the 
respective entry in the history log.  

Please check the requirements for uploading your files below. 

 

 

 

 

4.1. FAMILIARISING YOURSELF WITH THE WIZARD AND THE FORM 

Click the first  button at the top of the screen to read the general help instructions for editing 
proposal forms, as shown in the picture below 
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Click the  button in the Administrative Forms section to read the help instructions for editing the 
administrative forms of the proposal, as shown in the picture below: 
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Click  to start editing the forms.   
 

 

 

 

 

 

 

The form may not auto-fit the size of your currently open window, as shown in the picture above.  
 

 
 
  

Please see the Compatibility and Troubleshooting section at the end of this document for more information on your 
browser displaying the form in the open browser window or download it to your downloads file. If it is downloaded, 
you can work on the downloaded file offline. THE DOWNLOADED FORM HAS A TIME STAMP FROM THE 
COMMISSION'S SERVERS AND IT EXPIRES 2 HOURS AFTER IT IS DOWNLOADED .IF YOU DO NOT 
COMPLETE, SAVE AND CLOSE THE FORM WITHIN 2 HOURS, YOU MUST DELETE THE OLD FORM, 
RETURN TO THE WIZARD AND DOWNLOAD A NEW COPY OF THE FORM. The images below display the form 
inside the browser window. Whether displayed in a browser window or downloaded to work offline, the functionality 
of all buttons, fields, and the entire process are exactly the same. 
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You may need to adjust your window size, or the form size, or both: When adjusting the window size, 
the form opens on top of the Submission Wizard. 
 

 
 
 
Use the zooming (+/-) buttons to zoom in or out of the form. 
 
Alternatively, you can specify the percentage ratio in the % drop-down list: either select a pre-defined 
percentage from the drop-down list (i.e. 150%) or type the desired percentage directly into the field. 
 
You can also move the mouse cursor to the top of the form and move the form as needed. 
 
  



European Commission - Proposal Submission Service – User's Guide (04-11-2016)     Page 48 of 124 

What You Need to Know about Completing the Form 

Who Can Fill In the Form? 

The Main Contact (or the top-level role for calls with specific contact roles – see Appendix C at the end 
of this document) is the only person that can complete the form, including the budget table and all 
other administrative details. Partners can preview the form and edit their contact detail information. 

Click the  button to access the forms. 

Read-only Fields 

The list of participants and contact persons, the Participant Identification Code (PIC) and the 
respective summary data of the participants (shown in blue in the form) are read-only fields. To modify 
the list of participants or contact persons, please go back to Step 4. To modify the legal data of the 
organisation, please read more about it in this Data Update section. 

Guidance in the Form 

If you click on the question marks in blue, you can read more information about the question or 
section.  

Each box of the form contains a short text with guidance on the format, the length and required 
information. That text appears when you bring your cursor over the top of the box. Once you click on 
the text or start editing the information, it disappears automatically. 

Navigation in the Form 

To view the different sections in the form, you may either use the scroll bar or click on the blue "Show" 
buttons as seen in the Table of contents. 

Validation 

The form has built in checks and gives error or warning messages in case fields are not completed. 

Please click the  button to check your data. Errors and warnings will be listed at the end of 
the form. Error fields will be highlighted in yellow, whereas fields with warnings will be highlighted in 
red. Errors mean that mandatory information is missing (such as the Proposal Title) and the proposal 
cannot be submitted until these errors are corrected. Warning messages do not block submission, but 
they indicate missing information that may be important for the proposal. Ideally, these warning 
messages should be addressed by correcting the information provided. By clicking on the "Show" 
button, you can easily get back to the respective fields to correct them. 

Saving of the Data 

Before closing the form, click the  button. The save and close function does not validate 
the information in the form, so it works even if the form is not completely filled in. This will take you 
back to Step 5, where you can upload the Technical Annex and any additional documents. 

You may return to edit the form as many times as you wish before the closing date of the call . Any 
changes saved on the form need to be resubmitted in order to be received by the European 
Commission and considered for evaluation. 

Technical Requirements 

The configuration check tool, located on the bottom left-hand side of the submission system, 
automatically verifies if your system configuration complies with the minimum requirements. 
  

http://ec.europa.eu/research/participants/docs/h2020-funding-guide/grants/applying-for-funding/register-an-organisation/data-update_en.htm
https://webgate.ec.europa.eu/fpfis/wikis/display/ECResearchGMS/Minimum+Technical+Requirements
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Action Buttons within the Form 

Two action buttons in the PDF form help you find and verify the information easily. 

Button Description 

 

 

When you click this button, all data fields in the forms will be validated against a 
set of rules.  

The system assesses if the available data is valid, checks the data formats, 
performs computations, and checks interlinked data for consistency.  

Any issues found in the form are reported at the end of the PDF form. 

 

 

Click to save the completed administrative form and close it for editing.  

You can save your form data even if the form is not completely filled in - you can 
edit it at any moment prior to the deadline. Save and Close does not validate the 
data. 

 

4.2. EDITING AND COMPLETING THE FORM 

To start completing the form, scroll down or click the blue  button to navigate to the respective 
section of your form. This is primarily an administrative form that should include general information, 
administrative data of participating organizations, budget information by partner, and also Call-specific 
information.  

 

 



European Commission - Proposal Submission Service – User's Guide (04-11-2016)     Page 50 of 124 
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4.3. FORM VALIDATION, SAVE AND CLOSE 

You must click the  button to make sure that your application meets the administrative 
requirements. The form will run a self check and prompt you in case of errors or warnings, as shown in 
the picture below: 

 

The validation errors are shown in the picture below … 

 

… are highlighted in the body of the form. 

 

When all errors are corrected, the validation test will confirm that there are no errors.  
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When all issues are fixed, click the  button. Your form has now been saved on the 
Commission servers, but it is not yet submitted. Your proposal submission takes place next.   
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4.4. PART B - DOWNLOADING AND COMPLETING THE ANNEX FORMS 

 

Click on    to download the latest proposal requirements template in a readily 
editable RTF file.  
 

 
 
The template describes the information that must be included in your application and how to structure 
that information. You will need to complete this package as thoroughly as possible. You may want to 
also check with Enterprise Europe Network and your National Contacts Point for Assistance (see the 
Support menu of the Participant Portal). It is important that you remain within the file size and page 

http://ec.europa.eu/research/participants/portal/desktop/en/support/enn.html
http://ec.europa.eu/research/participants/portal/desktop/en/support/national_contact_points.html
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limits that a proposal may have. Once you have completed your proposal based on the downloaded 
template, you must convert it into a PDF file, which you will then upload as an Annex form of the 
proposal. This is referred to as Part B of your proposal. 
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4.5. UPLOADING THE ANNEX FORMS 

When you complete the annex forms, you must prepare them for uploading.  

A number of limitations and requirements are in place for each of the forms, depending on the call – 
such as, page size and page limit, document size limit, minimum font size, PDF format conversion 
issues, etc. 

Make sure that you first familiarize yourself with all the specific annex form limitations and 
requirements in the documentation available in the respective call's information package on 
the Participant Portal.  

The breach of certain limitations, such document size limits, could result in failure of the 
upload – as a result you may need to amend the documents and upload them again. If you 
exceed the page number limit, you will be still able to upload the document but all of the 
excess pages will contain a watermark.  

Your proposal will be considered ineligible if any one of these formal requirements is not met. 

The pictures below show a sample Part B form template with detailed instructions on the front page, 
including limitations for the page limit, font size, and margins: 
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In the process of completing your annex forms, and prior to uploading them, make sure that your 
documents comply with the above-mentioned requirements and recommendations, as generally 
outlined below. 

1. PDF conversion issues and checks. 

 Before you start the conversion to PDF, clean up your document - accept all tracked 
changes, delete internal review notes or comments, check for any formatting issues, 
and so on. The document to be converted to PDF must only contain the final, "clean" 
content. 

 Check that your PDF conversion software has successfully converted all the pages of 
your original document (e.g. check for any problems with page limits, tables, graphics 
or footnotes). 

 Check that your PDF conversion software has not cut down pages with landscape 
orientation to fit them into portrait orientation format. 

 Check that captions and labels have not been lost from your diagrams.  

 Embed all fonts in the PDF file (math symbols, non-Latin alphabet text, etc.). 
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2. Limitations in document page number, font size, and page margins. Each form 
template, depending on the specific call, may impose certain limitations in the document 
formatting with regard to the maximum number of pages in the document, the 
minimum/maximum font size allowed, and/or the minimum margins you must allow for in 
the page layout. 
 
Always make sure to check and apply the guidance for the specific call, available on the 
Participant Portal, as well as the instructions at the beginning of the annex form templates 
for each specific call.  
 
If you attempt to upload an annex form that contains more pages than the specified limit, 
you will not get an error message during the upload process. However, when you attempt 
to Validate the uploaded document, the system will display a warning message, advising 
you to shorten and re-upload the proposal in order to allow for it to be qualified as eligible - 
as shown in the picture below:  
 

 
 
If the number of pages in one of the uploaded documents still exceeds the allowed limit and 
the deadline has not yet expired, you will receive an automatic Eligibility Warning advising 
you to shorten and re-upload the proposal, as shown in the picture below: 
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After the deadline, any excess pages will be overprinted with a ‘watermark’, indicating to 
evaluators that these pages must be disregarded, as shown in the picture below: 
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3. Document file size. The allowed file size of annex forms may be limited, too. Check the 
guidance documentation available in the call's information package on the Participant 
Portal. 
 
When the document file size exceeds the allowed limit, the system will display an error 
message immediately during the upload process, as shown in the picture below: 
 

 
 

4. Graphical resolution. Use a maximum resolution of 300 dpi for all graphics and text 
(photocopy quality). This can dramatically reduce the PDF file size. 
 

5. Printer-friendliness.  

 Proposals will be printed out in black-and-white colour on plain A4 paper. If you have 
used other colours in your annex forms, make sure that they are correctly interpreted 
and visible as nuances of grey in the output PDF file. 

 Ensure that printing is done at 300 dots per inch and that no scaling is applied to make 
the page "fit" the window. Print a test copy of your PDF files before uploading them. 
 

6. Document file name and security. 

 Ensure that the annex forms file names contain alphanumerical characters only (A-Z, 0-
9). 

 Do not protect the uploaded files with a password. 
 

7. Post-upload verification. Once you upload your files, check their quality - download them 
to check whether the file transfer was successful and if the file is complete. If not, make the 
necessary corrections and upload again. 

Note: Make sure that the files you upload can be opened and printed without any problems! If 
the Commission encounters a problem when opening or printing a file you have uploaded as 
part of a proposal, the complete proposal will be considered ineligible. 
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Once the downloaded templates have been completed and are ready to upload: 

1. Click the  button for the respective document in Step 5 of the Submission 
Wizard. 
 

 
 

  



European Commission - Proposal Submission Service – User's Guide (04-11-2016)     Page 61 of 124 

2. Select the file to upload from the File Upload window. If your file has blank spaces in its 
name, the system will upload it filing the blank spaces with "_". 
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3. Click . A confirmation message will appear: 
 

 
 
Note: If the file uploaded is not in a valid PDF format, an error message will appear instead 
of a confirmation mail. 
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4. Click . The uploaded file will be shown in the list and a green check mark  will 
appear next to it, as shown in the picture below: 

 

 

5. Optionally, you can  an uploaded file and replace it with a new file. 
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4.6. VALIDATE AND SUBMIT YOUR APPLICATION 

To make sure that your application meets the requirements  click the  button. In order to make 
your application meet the requirements of partners, file sizes, number of pages, etc, you will be 
prompted to correct any errors that have been detected in the forms. Any errors will be displayed as 
indicated below: 
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Each error detail line is a link to the respective section of the form or to STEP 4. For example, clicking 
the link "Please go back to STEP 4"  will take you back to STEP 4,where you can fill in the missing 
information. 

When all errors and warnings are corrected, click the   button again to make sure you have 

not missed anything. Once you get the No Errors validation screen, click on . Your proposal has 
now been submitted and the system displays a message to confirm that the proposal has been 
received.  
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The Submitted status will also be shown on the My Proposals page of the Participant Portal. The 
Proposal Coordinator will also receive a submission confirmation e-mail, including details about the 
submitted proposal. Note that the e-mail could end up in the spam folder or get blocked by the anti-
spam software of your organisation, so make sure that you check your inbox regularly.  

The submission is completed when the Proposal Coordinator clicks , and receives an email 
confirming that the proposal has been received.  Uploading the Annex documents in itself does not 
finalise the submission process. Therefore, we advise you to upload your proposal as early as 
possible. There is a serious risk that you will not be able to submit it on time. 

You can upload your Annex documents or submit your proposal as many times as you wish prior to 
the call deadline, but it is strongly advised not to wait until the last few days to do so. Each time you 

upload a new Annex document, you must click to save your changes. 

USER ACTION #5: The 'Proposal Submitted' Page 

Reaching Step 5 means that your proposal has been successfully submitted and therefore sent to the 
European Commission services for evaluation.  

In Step 5 you can carry out the following actions, as indicated in the picture below: 

 

 

Revise (Re-edit) the Proposal 

If you need to revise your proposal, click the  button to go back to Step 5. 
The Proposal Coordinator may continue to modify the proposal and submit revised versions 
overwriting each preceding one right up until the deadline. 
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Note: This option will not be available to you if you attempt to revise a proposal which was submitted 
for a continuously open call. 

Download  Submitted  Proposal Package 

After submission of the proposal, it is advised to download your proposal in order to check that it has 
been correctly submitted.  

A digitally signed and time-stamped version of the latest submitted version of your proposal 
can be viewed/downloaded.  

 

 

 

Click the  button to download your proposal.  

Note: Depending on the volume of proposals submitted, this can take from a few seconds up to 
several hours. Please contact the Service Desk if it is not yet available 72 hours after call closure. 

 

Withdraw Submitted Proposal 

If the proposal is withdrawn, it will not be considered for evaluation. However, the system will keep the 
proposal draft and the withdraw action may be reversed by re-submitting the proposal before the 
specified deadline. You will have to enter a reason for the withdrawal.  

When a proposal is withdrawn, a message is displayed on the screen, as shown in the picture below. 
The system also sends a submission confirmation e-mail to the Proposal Coordinator, including the 
details of the withdrawn proposal. Note that the e-mail might get lost in your spam folder or get 
blocked by the anti-spam system of your organisations, so make sure that you check for it as needed. 
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Note: You will not be able to access this option if you attempt to withdraw a proposal, which was 
submitted for a continuously open call. 

To complete this action, click .. 

PARTNER ACTIONS 

To be added, a partner must have both access to ECAS and a PIC. When the Proposal Coordinator 

clicks  in Step 4, an automatic email will be sent to all the Partner contacts with the 
proposal related links. 

Once the Partners enter the electronic submission system, it will display Step 5 of the submission 

process where the  button enables them to access the electronic administrative forms and 
the rest of the proposal package as their participation requires. 

To access the consortium contact details, they will need to click the  button – thus going back 
to Step 4 of the submission process. 

Completing the forms 

When the PDF form is opened, the partner will have to verify or fill in their administrative form and 
make sure to correct any validation errors. To check for validation errors, partners must use the 
VALIDATE FORMS button located at the bottom of the page. 
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CHAPTER 3: REFERENCE GUIDE TO ROLES, SCREENS & 

ACCESS TO USER ACTIONS 

Roles, Proposal Coordinator, Partner, Contact Person 

The roles that are available in the system are the Proposal Coordinator, Partners, and Contact 
Persons (optionally). The Proposal Coordinator and each of the Partners have a Main Contact and 
can optionally have one or more additional Contact Persons. Depending on the proposal you 
participate in, you might act on behalf of one or more of these roles and your current role will 
determine the actions you will be able to carry out and the information that you will be required to 
provide. 

 Proposal Coordinator. The Proposal Coordinator acts as the single point of contact between 
the participants and the Commission for any given proposal. The Proposal Coordinator is 
generally responsible for the overall planning of the proposal; for building up the consortium 
that will do the work, and (s)he is always the first participant. Note that for some calls, only one 
participant is needed and the participant will be the Proposal Coordinator of the given proposal 
by default. 
 

 Note: A Proposal Coordinator can promote a partner organisation to Coordinator status via 
a drag-and-drop function as long as this partner organisation provided details of a main 
contact. Once this change has been implemented, all contacts of both organisations will be 
notified of the change in access rights. When swapping roles with a partner, the original 
coordinator contact(s) lose(s) the full editing and submission rights for the proposal. This 
functionality is not available for ERC/MSCA calls. 

 
 

 Partner. If you are a Partner to a proposal, you will be invited by the Proposal Coordinator to 
fill the administrative forms that contain the contact and address details. Most of the fields will 
be pre-filled with information already provided to the Commission services in order to save time 
and to ensure better data quality. 
 
Contact Person. Optionally, a Proposal Coordinator or a Partner may decide to delegate 
some of the work involved in filling in or reviewing parts of the proposal submission forms to 
one or more additional Contact Persons. You can grant each Contact Person full access rights 
or read-only access to the forms data. A Contact Person will only be entitled to edit/view the 
parts of the proposal that his/her organisation is responsible for. 
 
Note: A Contact Person with full access rights cannot change their own access rights level to 
'read-only' – this can only be done by the Proposal Coordinator or another user with full access 
rights.  
However, a contact person with access rights to a proposal will be notified whenever they 
are deleted from the list of contacts pertaining to an organisation. When an entire 
organisation (including all of their contacts) is deleted, all contact persons will receive an email 
informing them that their access rights to this particular proposal have been revoked.              
 

 Calls with Specific Contact Roles. Most calls use the standard Main contact and Contact 
person roles for the Proposal Coordinator organisation. However, some calls (e.g. ERC-2014 
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and H2020-MSCA-IF-2014) may require more specific roles, such as Principal Investigator, 
Main Host Institution Contact, Researcher, Supervisor, Applicant, and so on. Calls of this 
type are pre-configured accordingly so that the proposal submission forms for them contain 
special sections to address the specific roles and the respective data as needed. Likewise, the 
Proposal Submission Wizard for these calls will display the respective role options, as 
configured for each call. For more information about calls with special roles, see Appendix C: 
Calls with Specific Contact Roles at the end of this document. 
 

Changing Main Contact Information 

Only one Main Contact is allowed for each organisation. However, for business reasons, you may 
need to change the Main Contact person details after the initial Main Contact assignment. For 
example, you can edit the Main Contact details of the existing person, or you can assign an existing 
Contact Person as the Main Contact replacing the original one, or you can first delete the Main 
Contact and then add a new one, etc.  

When the information about the existing Main Contact changes (or when you delete it), the system 
will display a confirmation prompt warning you that you would lose the previous Main Contact data. If 
you change an existing Contact Person as a Main Contact, or if you add a new contact person in the 
Main Contact role, the previous Main Contact will automatically become a Contact Person – the two 
roles will be reversed.  

In addition, all changes in the Main Contact details will be automatically reflected in the Administrative 
Form. 

Role Rights 

The following table highlights the differences between a Proposal Coordinator and Partner actions: 
 

Action Proposal Coordinator Partner 

Select the call Yes No 

Add, Invite Participants Yes No 

Submit the proposal Yes No 

Read complete proposal Yes Yes 

Define the budget tables Yes Yes, with full rights only row for 

organisation that user belongs to 

Create Contacts for a Partner Yes Yes, with full rights, only for 

organisation that user belongs to 

 

 

The Timeline around the Deadline 

Proposals can be submitted multiple times before the call deadline specified in the information 
package of the call, available from the Participant Portal. Calls deadlines are fixed and will 
normally not be extended. Only the most recently submitted version will be evaluated, whereas 
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each newly submitted version overwrites the previous one. After the call deadline, the proposal 
can no longer be modified and no further participants can be invited. Practise the proposal 
submission procedure well before the deadline to ensure a risk-free submission of your proposal 
and proper correction of errors and warnings.  
After the deadline, the proposal remains available in read-only mode and can be accessed by the 
coordinator and the proposal participants before the deadline. 

The Online Submission Wizard: Screens and Access to User Actions 

The electronic submission system screen is composed of the following elements: 

 A progress bar banner showing the proposal completion progress. 

 Buttons for the available actions. 

 The ID card of your proposal – shown on the left-hand side of the screen. The information 
displayed there is completed as the user progresses. You can click on the Acronym, ID, PIC, 
and Contact tabs.  

 Configuration status check tool – it is displayed in the bottom left part of the screen. In the 
visual example below, the configuration complies with the minimum requirements.  

 Navigation buttons available in the bottom right corner of the screen.  

 

The most important pages of the online submission wizard are briefly described below. 
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1. Progress bar  

2. Proposal information panel 

3. Proposal ID card 

4. Configuration status check tool 

5. Action buttons 

 

 

Wizard Step 3: CREATE DRAFT 
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The picture below shows the CREATE DRAFT screen of the wizard: 
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1. Enter your organisation Search criteria 
2. Select a previously associated organisation 
3. Click to start the organisation Search procedure 
4. Select your role Main contact or Contact person 
5. Enter proposal acronym 
6. Enter proposal short summary 
7. Click the Next button 

 
 
 
Wizard Step 4: PARTIES 

The picture below shows the PARTIES screen of the wizard: 
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1. Click to add a new Partner 
2. Click to open Help instructions 
3. Warning on the required number of participants  
4. Add contact 
5. Contact info 
6. Edit contact 
7. More info 
8. Next button  
9. Edit participant information 
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Wizard Step 5: EDIT PROPOSAL 

The picture below shows the EDIT PROPOSAL screen of the wizard: 

 
 

 
 

1. Click to open general help instructions for editing proposal forms 
2. Click to open specific help instructions on forms editing 
3.  Action buttons 
4. Click to open specific help instructions on uploading documents 



European Commission - Proposal Submission Service – User's Guide (04-11-2016)     Page 78 of 124 

5. Click to download latest proposal requirements package 
6. Click to upload required document 
7. Click to delete an uploaded document 
8. Indication if the required document was uploaded 
9. Indication if a required document is missing 
10. Document upload help  
11. Navigation and action buttons
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Wizard Step 6: SUBMIT 

The picture below shows the SUBMIT screen of the wizard: 

 

 

 

 

 

 

 

 

The Participant Portal: Screens and Access to User Actions 

The Research and Innovation Participant Portal is your entry point to the Online Submission Service. It 
allows you to carry out the following actions: 

 Familiarize yourself with the overall research and innovation grant process by first consulting 
the HOW TO PARTICIPATE page on the Participant Portal. 

 Decide on the funding opportunity that you want to apply for. 

 Select your Partners – check Partner information in the Beneficiary Register. 

 Register as a user in ECAS. 

 Register your organisation and your Partner organisations in the Beneficiary Register. 

 Login to the Participant Portal and Select your Topic to access the Online Submission Service. 

 Use the MY AREA > My Proposals / My Organisations pages to access your draft and 

submitted Proposals. 

https://ec.europa.eu/research/participants/portal/desktop/en/home.html
http://ec.europa.eu/research/participants/portal/desktop/en/funding/index.html
https://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
https://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
https://ec.europa.eu/research/participants/portal/desktop/en/proposals/index.html
https://ec.europa.eu/research/participants/portal/desktop/en/organisations/index.html
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Participant Portal: Before You Log In 

Create an ECAS account or, if you already have an account, log in to your ECAS account. Before 
logging in, familiarize yourself with the grant process, the funding opportunities and check Partner 
information. 

 
 
 

 

 

Participant Portal: The ECAS Login Screen 

When you click , you will be prompted to log in through the ECAS login screen, as shown in 
the picture below. This screen appears in the same window and after login (or registration) you will be 
redirected to the Home page of the Participant Portal. 
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Participant Portal: The ECAS Login Domain Selection Screen 

Once logged in, your personalised MY AREA tab appears. Here you can access your Organisations, 
Proposals, Projects, Notifications, and Experts. 
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Participant Portal: The HOW TO PARTICIPATE Page 

This page is your main source of information as you prepare for submitting your proposal. It allows you 
to: 

 Register your and your Partners' organisations in the Beneficiary Register 

 Read the H2020 Online Manual and a number of Reference Documents 

 Carry out a Financial Capacity Self-Check 

 Check the conditions regarding SME Participation 
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Participant Portal: The BENEFICIARY REGISTER Page After Login 

The Beneficiary Register page is accessible via the HOW TO PARTICIPATE page. It allows you to: 

 Search through the registered organisations database and check if your desired Partners' 
organisations are already registered in Participant Portal. 

 Start (or Resume) the organisation registration process via the Beneficiary Register. 

 
 

  

http://ec.europa.eu/research/participants/data/support/manual/urf.pdf
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Participant Portal: The FUNDING OPPORTUNITIES Page 

The Funding Opportunities page is your access point for searching and selecting Calls for proposals. 
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Participant Portal: The CALLS Search & Selection Page 

The CALLS search & selection page for the selected Programme contains a filtering/search panel at 
the top of the page and a result list of Calls (depending on your filtering criteria) in the form of clickable 
boxes situated below. If you tick a specific Call box, you will be directed to the Call Details page for 
that Call. The picture below shows a list of Horizon 2020 calls. 
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Participant Portal: CALL Details - TOPIC Selection for a CALL 

When you select a Call to submit a proposal for, you must select a Topic in the Call description tab 
that opens. 
These tab pages provide detailed information about the selected Call. To proceed to proposal 
submission, select a Topic from the list. 
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Participant Portal: Accessing the Submission Service for a Selected Topic 

 

After you select the Call and the specific Topic, click  to start the Proposal 
Submission process in the Online Submission Wizard, which will open in a new window (see the 
previous section for a more detailed description of these screens). 
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The Submission Service tab is your access point to the Online Submission Wizard. 

 
Select the Type of Action from the drop down menu (usually there is just one Action) and then click 
on the START SUBMISSION button to go to the Online Submission Wizard. 

 

Participant Porta: MY ORGANISATIONS Page After Login 

Log in and go to your personalised MY AREA tab, where you can access your Organisations and 
perform different actions related to them – view or modify organisation details, view proposals for 
these organisations, view roles, and view projects. 
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Your personalised MY AREA tab – click My Organisations to see a list of your registered (or draft) 
organisations (organisations that you have a role with). 

In the list of your organisations, you can use the View Proposals action button in case you have draft 
or submitted proposals for that organisation. 

In this visual example, the registration process for the organisation in the list is not yet complete, so 
the system provides an option to continue the organisation registration process.  

 

Participant Portal: The MY PROPOSALS Page After Login 

After you log in, you will be able to use your personalised MY AREA tab, where you can access your 
Proposals – drafts or submitted ones. The visual example below shows a proposal list with two draft 
proposals:  
In the list of proposals, each proposal will have a specific set of action buttons available depending on 
its state, as described in the LEGEND area above the list.  
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APPENDIX A: COMPATIBILITY & TROUBLESHOOTING YOUR 

SYSTEM CONFIGURATION 

 

 

Mandatory System Requirements 

The electronic submission system of the European Commission is a web application, so you will need 

a working Internet connection to use it. Although the system has been tested with a set of typical 

reference configurations, it is not guaranteed that the system will be fully functional on your computer. 

The system provides a diagnostic window that will warn you about some possible incompatibilities. 

To use the electronic submission system, ensure that your computer configuration complies with the 

following mandatory system requirements: 

Component Mandatory requirements 

Adobe Reader Version X or above, all previous reader installations must be removed prior to 

installing the latest version 

Adobe Acrobat X Pro needs to be updated to the latest version (10.1.15). 

Internet 

connection 

ADSL Line, 512 Kbps or faster 

Memory RAM – 512 MB of more 

Screen 

resolution 

Minimum 1024 x 768 of higher 

JavaScript JavaScript must be enabled 

Cookies Cookies must be enabled 

Pop-up blocker No effect 

User ID Valid user ID with the Commission (ECAS account) 
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Recommended system configuration 
 
The following table shows the operating systems and browsers actively supported by the system, as 
well as the Adobe Reader version required for each configuration. 
 

Operating system Internet browser Adobe Pro or Acrobat Reader 

Windows Vista & 7 Internet Explorer from 8 to  11 
Firefox 3.6 or above  
Chrome from 10 to 44 

Version X or above 

Windows Vista 10 Firefox 40 
IE 11 
Chrome until 44 

Version X or above 

Mac OSX Safari 5 or above Version XI 
  

Linux 
(Xubuntu 14.04) 

Firefox 28.1 Version 9.5.5 

  

 
Note: The use of mobile devices for online submission of research proposals is not supported. 
 

 

Troubleshooting Your System Configuration 

The primary compatibility issue concerns the seamless viewing and editing of the pdf forms inside 

your browser window once you click  . Your browser will either display the forms in a 
window or download them to your computer (after downloading them, you will be able to open 
them in Acrobat Reader X or XI and complete them. Whether you work on the form inside your 
browser window or with Acrobat Reader after downloading them, the end result is the same. In 
either case, as described in User Action 4 above, once you click Validate, the form will perform a 
check and provide you with the corresponding notices, When you click Save and Close the 
information will be sent to and saved on the Commission's servers. REMEMBER: THE 
DOWNLOADED FORM HAS A TIME STAMP FROM THE COMMISSION'S SERVERS AND IT 
EXPIRES 2 HOURS AFTER IT IS DOWNLOADED .IF YOU DO NOT COMPLETE, SAVE AND 
CLOSE THE FORM WITHIN 2 HOURS, YOU MUST DELETE THE OLD FORM, RETURN TO 
THE WIZARD AND DOWNLOAD A NEW COPY OF THE FORM. 
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The bottom left side of your wizard will indicate whether your system is configured to display the 
form directly in your browser window: 

          

Configuration OK: your system meets the minimum requirements and all PDF forms will open 
directly in your browser. 

Configuration unconfirmed: your browser does not meet the minimum requirements and all PDF 
forms will be downloaded and opened offline, outside your browser. 

What to do if your system configuration is not OK? 

1. Make sure you have the correct version of Adobe Reader installed (see compatibility section 
above) and set up as your default PDF handler. If you have an older version of Adobe Reader, 
uninstall it before installing the new version. To download Adobe Reader, go to Adobe Reader 
Download and follow the instructions. 

2. Most browsers have their own built-in PDF viewers. If your browser's built-in PDF viewer is not 
allowing you to properly open, view and edit the Administrative form in step 5, it is 
recommended that you disable your browser's PDF viewer and instead use the corresponding 
Adobe Reader plug-in. This way you will be able to open up, view and edit the form within the 
browser. As stated above, you can also complete the form offline and then save it to the 
Commission servers,. 
 

The following instructions explain how to enable the Adobe Reader plug-in for the supported 
browsers and operating systems. 

 

  

http://get.adobe.com/reader/
http://get.adobe.com/reader/
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On Windows 

Internet Explorer 7, 8 and 9 

The steps to enable the Adobe PDF plug-in vary depending on your version of Internet Explorer.  

 Select Tools and click Manage Add-ons.  

o (Or select Tools > Internet Options, click the Programs tab, then click Manage Add-
ons.)  

 In the Show pop-up menu, select All Add-ons.  

o (In some versions the option reads: Add-ons That Have Been Used by Internet 
Explorer.)  

 Scroll to the section of add-ons for Adobe Systems and select Adobe PDF Reader. 

 If the status of Adobe PDF Reader is set to Disabled, click the Enable button. 

 Click OK to confirm. 

Firefox 3.6 up to 18 

 Select Tools and click Options.  

 Click the General tab, then click Manage Add-ons. 

 Click the Plug-ins tab (purple/blue icon). (The layout of this dialog box differs depending on the 
version.) 

 Find and select Acrobat or Adobe Reader: 

 If the Disable button is displayed (as shown above), the add-on is enabled and no action is 
required. 

 If the Enable button is displayed, click Enable.  

Firefox 19 and above  

Please note that Firefox 19 and above has a built-in PDF viewer. You will need to enable the 
Adobe PDF reader plugin. 

 Click Tools and then click Options 

 Select Applications 

 In the Content Type column, find Adobe Acrobat Document and click to select it 

 In the Action column, click the corresponding drop-down arrow and select "Use Adobe Acrobat 
(in Firefox)".  
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Google Chrome 

Google Chrome uses the Chrome PDF Viewer as the default application to open PDF files. In 
order for the system to open up the PDF eForms within the browser you must disable Chrome 
PDF viewer 

 

 On your browser type chrome://plugins  

o the Plug-ins page will be displayed 

 Disable Chrome PDF Viewer 

 Enable Adobe Acrobat plug-in 

 

Older Google Chrome version plugins page: 
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Latest Google Chrome version plugins page: 
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Manage your settings to use the offline form with Chrome 

 

Adobe plugin support for Google Chrome ends with version 45. Plug-in support will also be 
discontinued for Microsoft Edge. Because of this, it will no longer be possible to work with Part A 
forms online. It will, however, still be possible to work in the offline mode. This section aims to 
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facilitate the configuration of Chrome and Adobe to be able to work in offline mode. You can, 
however, still work with the offline forms using Adobe Acrobat X Pro in version 10.0.0.  All 
screenshots shown in this section feature the Adobe Acrobat Reader 10 or higher.  

 

It is advised to work rather in online mode using alternative browsers that support the Adobe 
Reader plugin rather than working in the offline mode. You can find the list of browsers supported 
in the "Minimum Technical Requirements" page. 

 

Important information for users working in the online mode: 

You may use previous versions of Chrome (version 43 or 44) when working in the online mode. To 
work in the online mode, you will need to update Adobe Acrobat X Pro to the latest version 
(10.1.15).  

 

Please note that you will have to update Adobe Acrobat X Pro to the latest version 
(currently: 10.1.15) and check your Firefox settings accordingly as shown in the figure 
below.  

 

 

Open a new tab in your browser and go to Tools > Options > Applications and select 'Use 
Adobe Acrobat in Firefox'. 
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You can download the latest version of Adobe Reader here: 
https://www.adobe.com/support/downloads/product.jsp?product=1&platform=Windows 

 

 

 

 

 

 Set Adobe Reader as default PDF viewer in your system 

 

If Adobe Reader XI (or X) is not set as PDF viewer in your system then perform the following 
steps: 

Open Adobe Reader and navigate to Edit -> Preferences: 

 

https://www.adobe.com/support/downloads/product.jsp?product=1&platform=Windows
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Select <General> and press <Select as Default PDF Handler>: 

 

In Adobe Reader XI and X also the following popup window appears. Select Adobe Reader XI MUI 
(or X) and press <Apply>. 

 

If the <User Account Control> popup window appears then press <Yes>. 

Double Click any PDF file stored locally in your PC and check whether it opens in Adobe Reader. 
If not, restart your system. 
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 Disable Chrome PDF Viewer 
 

The configuration shown below concerns Chrome version 45 and is expected to work from 
Chrome version 42 to version 46. 

 

If you received the following warning message, then disable your browser's PDF viewer following 
the steps described below. 

 

Open Chrome browser and navigate to "chrome://plugins/" 

Disable Chrome PDF Viewer. 

 

Restart your computer. 

 

Safari 5 

 Choose Action menu > Preferences and click Security. (The Action menu is near the upper-
right corner of the Safari window, and looks like a gear.) 

 Make sure that the "Enable plug-ins" checkbox is selected 

 

Safari will by default display PDF files using the Adobe Reader plug-in. 
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Opera 19 

The latest Opera version will not display the pdf forms inside the browser. It will automatically 
download them in your download folder. You will need to open and work on them using the Adobe 
Reader or Adobe Pro application. When you are ready to click on the embedded Validate Form 
link or on the embedded Save and Close link, make sure your computer is connected to the 
internet, so that the information can be automatically validated or uploaded and saved to the 
Commission's servers. 
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On OS X 

In OS X, the latest versions of Adobe software, Acrobat 10.1.x or XI and Reader 10.1.x or XI 
support viewing of PDF files only inside the Safari browser. Other browsers, such as Firefox, 
Chrome and Opera, are not supported. We suggest you use Safari. 

 

If Safari does not display PDF forms in the browser window, uninstall all older versions of Adobe 
Reader and download the most recent one. First close Safari and then install Reader. Launch 
Safari to open the PDF files inside the Safari window. If you install Adobe Reader 10.1.x without 
first closing Safari, Safari will not display the PDF file inside its browser window until it is re-
launched. For further help, please see http://helpx.adobe.com/acrobat/kb/troubleshoot-safari-plug-
acrobat-x.html  

 

These are the respective error messages on the bottom left side of your wizard window for Firefox, 
Chrome, Opera and Safari 

   

 

The PDF viewer browser plug-ins for Firefox, Chrome and Opera will not work because the form 
format is not supported by the plug-ins, and it will not display. These browsers will automatically 
download the form to your download folder and you will be able to complete it offline. 

 

 

Setting Adobe reader in Safari 7 and above 

Trust the PDF plug-in globally  

1. Select Safari > Preferences > Security > Manage Website Settings.  

2. From the left panel, select Adobe Reader or Adobe Acrobat. 

3. From the When visiting other websites pop-up menu, choose Always Allow. 

 

http://get.adobe.com/reader/
http://helpx.adobe.com/acrobat/kb/troubleshoot-safari-plug-acrobat-x.html
http://helpx.adobe.com/acrobat/kb/troubleshoot-safari-plug-acrobat-x.html
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To open the form, Adobe reader must be set as the default PDF reader. 

 

Setting Adobe reader as the default PDF viewer 

1.  In the Finder, select a PDF, and choose File > Get Info 

2. Click the arrow next to Open With 

3. Select either Adobe Acrobat or Adobe Acrobat Reader 
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4. Click the Change All button 

 

5. When asked if you want to change all similar documents, click Continue 

 

 

 

 

 



European Commission - Proposal Submission Service – User's Guide (04-11-2016)     Page 108 of 124 

Troubleshooting Document Structure 

You receive the following message: "The European Commission digital signature (eReceipt) of the 
submitted proposal is not validated" after downloading your submitted proposal. 

The following procedure is only applicable for Windows operating systems  

After downloading the submitted proposal:  

• Click the signature located at the table of contents page  

• Click 'Signature Properties…' in the Signature Validation Status window  

 

• In the Signature Properties window click ' Show Signer's Certificate…' 

  

• Select 'Trust' tab and Click 'Add to Trusted Identities' in the Certificate Viewer window  
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• Click 'OK' to confirm in the Acrobat Security pop-up window  
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• The Import Contact Settings window should be displayed  

 

• Tick 'Use this certificate as a trusted root' and click OK (note: ticking 'Certified documents' is not 
required)  

• In the Signature Properties window click first'Validate Signature' and then 'Close'  

 

• The Commission digital signature or eReceipt should be validated 
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APPENDIX B: ECAS REGISTRATION 

To use the Online Submission Service, you need to have a personal user account with the 
European Commission Authentication Service (ECAS).  

To create an ECAS account, follow the instructions below.  

Note: For additional information, see the H2020 Online Manual.  

ECAS registration steps: 

1. Go to the Participant Portal:  
http://ec.europa.eu/research/participants/portal/desktop/en/home.html 
 

 
 

2. Click . 

http://ec.europa.eu/research/participants/docs/h2020-funding-guide/index_en.htm
http://ec.europa.eu/research/participants/portal/desktop/en/home.html
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3. The ECAS Sign Up screen appears: 
 

 
 

All fields in the registration form are mandatory.  

4. Optionally, click the link [Help for external users] if you need additional instructions. 

5. Choose a username and enter it in the Choose a username field. 

6. Enter your First name and your Last name. 

7. Enter your E-mail. When registration is complete, a confirmation email will be sent to this 

email address. 

8. Enter your e-mail address again in the Confirm e-mail field. You will receive an error 

message and you will have to enter the email again if it does not match the e-mail address 

provided in Step 3. 

9. Select the E-mail language that you want the European Commission to use for e-mail 

communication with you. 

10. In the Enter the code field, enter the five characters shown in the blue box above the field. 

For security reasons, the characters are not displayed clearly and may not be copied from 

the blue box. 
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If you cannot read the characters in the blue box or if you enter them but you receive an 

error message, try the following: 

a. Click  to reload a different character combination and enter it in the Enter the code 

field. 

b. Click  to hear an audio recording of the characters. You will need to use your 

computer speakers or headphones – make sure you have adjusted the volume to a 

comfortable level. 

11. Click the privacy statement link under the Enter the code field and read it in the window 

that opens. If you agree with it, close the privacy statement window and select the 

respective check box under the Enter the code field. 

12. Click . 

13. If you have not provided the required information in the fields, or you have entered a wrong 

code or an email address in an incorrect email format, the system will prompt you to go 

back and correct the errors before you can sign up. 

14. The following message will appear to confirm that your account has successfully been 
created: 
 

 
 

15. The system will send you a confirmation email to the email address you provided in the 
sign-up form. Open the email and click the activation link provided to activate your account. 
The link will expire after 90 minutes. 
 
Note: Make sure to check your spam folder if you cannot find the confirmation email in your 
inbox. 
 

16. Enter a valid password following the instructions on the screen. 

17. The following message confirms the creation of your account: 
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18. To log in to your new account, go back to the Participant Portal: 
(http://ec.europa.eu/research/participants/portal/desktop/en/home.html) and click 

. 
  

http://ec.europa.eu/research/participants/portal/desktop/en/home.html
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APPENDIX C: CALLS WITH SPECIFIC CONTACT ROLES 

Most calls use the standard Main contact and Contact person roles for the Proposal Coordinator 
organisation. However, some calls may require more specific roles, such as Principal Investigator, 
Main Host Institution Contact, Researcher, Supervisor, Applicant, and so on. The call roles are 
specific to the call. Calls of this type are pre-configured accordingly, so that the proposal 
submission forms for them contain special sections to address the specific roles and the respective 
data as needed. Likewise, the Proposal Submission Wizard for these calls will display the 
respective role options, as configured for each call. 

Call: H2020-MSCA-IF-2014  

Contact roles: 

 Researcher (one person with this role is mandatory for the proposal submission) 

 Supervisor (one person with this role is mandatory for the proposal submission) 

 Contact 

The following picture shows the Step 3 screen for the H2020-MSCA-IF-2014 call: 
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IMPORTANT: Make sure that you have assigned the mandatory Researcher role before you 
submit the proposal. You can add only one Researcher - if you need to re-assign this person to 
another role/e-mail and then assign another person as a Researcher, you must first change the 
current Researcher role to Contact person before you can add a new Researcher. 

Note: Once you have added the Researcher role, the remaining contact roles will only be 
displayed when you add or edit another contact role. 

Call: ERC-2014-CoG (call with Fellow contact roles) 

Contact roles: 

 Principal Investigator (one person with this role is mandatory for the proposal submission) 

 Main Host Institution Contact (one person with this role is mandatory for the proposal 
submission) 

 Contact person 

The following picture shows the Step 3 screen for the ERC-2014 call: 
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Note: The following limitations regarding the assignment and reassignment of contact roles 
apply: 

 There can only be one Principal Investigator role assigned to a proposal for a call. This 
means that if you initially created a proposal for a call as a Contact person assigned in 
Step 3 of the submission wizard, and you then add a Principal Investigator contact role, 
you would not be allowed to change the Contact person role to Principal Investigator 
because the latter role already exists. 
 

 If you create a proposal for a call as a Contact person assigned as the initial contact in 
Step 3 of the submission wizard, and you then add a Main Host Institution contact to 
the proposal, you will be able to change the Contact person to Main Host Institution 
after a confirmation prompt that the main contact would change, as shown below: 
 

 

Note: 'Main contact' in this context means Principal Investigator contact or Main Host Institution 
contact. 

Note: Once you have added the top-level contact role (Principal Investigator), the remaining 
contact roles will only be displayed when you add or edit another contact role. 
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GLOSSARY  

 

Term Definition 

Applicant  Generic term for any person/organisation that prepares and/or submits a proposal. There are two types of 

applicants: 

 The proposal coordinator 

 The partner 

The "Proposal Coordinator" role is allowed to register and to submit the proposal, while the 'Partner' role is 

only involved in the preparation of the proposal. 

Synonyms: Partner 

Beneficiary A beneficiary or "beneficiary of the European Union funds" refers to the legal entity that signs a grant 

agreement and/or procurement contract (i.e. the grant beneficiary and/or contractor) with an "entity managing 

EU funds". Depending on the management mode this entity may be the European Commission, a beneficiary 

country, an international organisation, or a Community or national agency. 

Subcontractors or suppliers as well as partners/consortia members of the beneficiaries are not concerned.  

(http://ec.europa.eu/europeaid/work/funding/beneficiaries_en.htm) 

Synonyms: participant 

Broader term: partner 

Beneficiary Register An electronic system that enables organisations to register their details once and then use this registration for 

one or more participations, thus eliminating the need to provide the same information for multiple proposal 

submissions. The Web interface of the Beneficiary Register is accessible from the Beneficiary Register page 

of the Participant Portal:  

http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html 

The Beneficiary Register also provides an organisation search tool where you can check if your organisation 

has already been registered as a participant. 

Call An invitation to third-parties to submit a proposal in order to get funding. Calls cover specific research areas 

and are always issued in the context of a Work Programme. 

All calls are announced in the EU's Official Journal and are published on the FP7 section of the CORDIS 

website. 

 

Call for proposals  

The European Commission publishes calls for proposals. It is an official invitation to submit a project proposal 

for a specific area of a framework programme by a specific date. Calls specify very clearly what is required in 

the Work Programme. Calls for proposals are officially published in the European Union Official Journal and 

on participant portal. 

 

1-stage calls 

For most calls, you submit a full proposal by the given deadline. 

 

2-stage calls 

Some calls have a 2-stage submission procedure, as follows: 

 Stage 1: You submit an outline proposal (standard maximum 15 pages, unless otherwise specified in 

the respective work programme, and on the proposal template in the submission system). This is 

evaluated against criteria set out in the call/topic.  

Note: For continuously open calls, your stage-1 proposal will be evaluated as soon as it is 

received, and there will be a closure date for submitting your full proposal in stage 2. Proposals 

submitted for continuously open calls cannot be re-edited or withdrawn. 

 Stage 2: If your proposal passes stage 1, you will be invited to submit your full proposal within a 

given period. If required by the relevant work programme, at this stage you will also receive the 

stage-1 Evaluation summary report (ESR). 

 Rejected proposals: If your proposal does not pass stage 1, you will be informed of this in writing, 

along with the evaluation summary report. 

http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
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Consortium agreement  The Consortium Agreement provides the legal basis for the internal relationship and responsibilities among 

the beneficiaries, and must be consistent with the provisions of the Grant Agreement. The Consortium 

Agreement is mandatory for all projects unless specifically excluded by the terms of the call for proposals. 

Such agreements do not affect the rights of the Commission/REA arising from the Grant Agreement and the 

corresponding obligations of the beneficiaries vis-à-vis the Commission/REA 

Consortium  A Consortium is a group of Participants, one of which is identified as the Proposal Coordinator in the proposal 

submission. The Consortium is represented to the Commission by a nominated Proposal Coordinator Contact, 

who is normally an employee of the Proposal Coordinator Organisation but who acts on behalf of all for most 

aspects of the project. 

 

In the context of a running project, the following constraints shall hold: 

 

 There shall be exactly one Proposal Coordinator Contact within each Project Consortium. 

 The Coordinator Contact identified in the Project proposal shall be a person, nominated from within 

the Coordinator Organisation, to be recognised by the Commission as the primary point of contact 

between it and the Consortium. 

 Each Partner in the Consortium shall nominate a Partner Contact as its representative in the Project, 

who shall also be identified to the Commission. 

 LEARs in the Consortium may revoke the Partner Contact representing their organisation in the 

Project. 

Deadline For each particular call, this is the moment after which proposals cannot be submitted to the Commission. At 

this point the Submission system closes for the respective call. Deadlines are fixed and strictly enforced. 

ECAS The European Commission's Authentication Service - it is the system for logging in to a whole range of web 

sites and online services run by the European Commission. Once you use ECAS to log in to a Commission 

website, you will not need to identify yourself again for other Commission websites until you browser session 

expires. 

Entry into force date  It is the date when the grant agreement enters into force. 

In general, this is the date when the last party has signed the grant (it can be the coordinator or most 

commonly the Commission). 

ERC  European Research Council  

Ethics issues Ethics issues are to be addressed by project proposals that involve the collection/experimentation with 

humans (including clinical trials), and/or human tissue, the collection or processing of personal data, human 

surveillance and intervention of any kind of experimentation with animals, genetic information, etc. Proposals 

that raise research ethics issues or those that do not address them adequately are usually identified by the 

scientific evaluation as needing additional attention by an Ethics Screening and/or Ethics Review Panel (ethics 

screening and ethics review are parts of the ethics review process). 

Ethics in H2020 is important throughout the project lifecycle, from the concept and the initial design until the 

dissemination of results. 

If there are ethics issues associated with or raised by a project, the applicants must describe how these will be 

dealt with in Annex I to Grant Agreement. 

Finalize GPF 
For the GPFs to be finalised and correctly sent to the Commission/REA, three forms have to be signed 
manually: 
·         One Form A2.5, 'Our Commitment,' per beneficiary has to be signed by the authorised representatives 
of the coordinator and each participant; 
·         Form A2.6, 'Data Protection and Coordination Role,' has to be signed by the coordinator's authorised 
representative; 
·         Form A4, 'Bank Account,' must bear the bank stamp and the signature of the bank representative (if the 
account is not already validated by the Commission/REA, which will be checked by the Project Officers) as 
well as the account holder's signature, with date. 
The finalised GPFs are submitted to the Project Officer in one unbound copy on white paper with original 
signatures. 

Host Organisation  The target organization of a Marie Currie (MC) proposal, an institution where the work described in the 

proposal will take place, and the organization that will be receiving funding associated with the proposal. (Also 
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see: Fellow)  

Indirect cost method 

ICM 

It is the method for determining indirect costs (the so-called ICM). Please note that the choice of an ICM for a 

legal entity depends on its legal status and accounting methodology and it is usually valid for the entire 

duration of FP7. In FP7 all departments, faculties or institutes which are part of the same legal entity must use 

the same system of cost calculation (unless a special clause providing for derogation for a particular 

department/institute is included in the GA).The choice of the ICM should be carefully assessed.  

If a change of the ICM is required, it will have an effect only on future grants with the exception of the 

correction of mistakes, further details are given in the Amendments Guide. 

(ftp://ftp.cordis.europa.eu/pub/fp7/docs/amendments-ga_en.pdf). 

Legal Entity Appointed 

Representative 

LEAR 

The LEAR is a person nominated in each legal entity participating in Research (H2020, FP7) programmes. 

This person is the contact for the Commission related to all questions on legal status. He/she has access to 

the online database of legal entities with a possibility to view the data stored on his/her entity and to initiate 

updates and corrections to these data. The LEAR receives a Participant Identification Code (PIC) from the 

Commission (see below), and distributes this number within his/her organisation. 

Operator Internal user responsible for the management of the application and of the operational call.  

Panel Review When there are insufficient funds to award grants to all proposals that achieve a qualifying score in the 
evaluation, a review panel will: 

 review the scores and comments for all proposals within a call to check for consistency across the 
evaluations 

 if necessary, propose a new set of marks or revise comments, and resolve cases where evaluators 
were unable to agree 

The panel may comprise experts from consensus groups, new experts, or a combination of the two. There 
may be one panel covering the whole call or several panels covering different parts of the call. Each panel will 
be responsible for one or more ranked lists, as defined by the indicative budget and call conditions set out in 
the work programme. 

The panel will recommend a priority order for proposals with the same score, using the procedure given in the 
work programme. 

Part A This is the part of a proposal deals with administrative data. It is completed using the web-based electronic 

Submission system. 

Part B – Template 

download and 

submission 

This is the part of a proposal that explains the work that must be carried out and the roles and aptitudes of the 

participants in the consortium. This part is uploaded to the electronic Submission system as a PDF file. 

Part B template The template documents are intended to provide you the topics that you will need to expand upon as part of 

the supplied by the Commission and are downloadable in step 4 of the Submission wizard. They are in RTF 

format consisting of a template of all chapter headings, forms and tables required to prepare a proposal Part 

B. 

Participant The Participant (short form of 'Participating Legal Entity') is a legal entity that has registered, or has a 

registration application pending, to participate in current or future proposals for research projects. A Participant 

must be validated (corporate) as a legal entity, uniquely identified within the Participant database by its 

Participant Identification Code (PIC). 

Participant registration is made through the Beneficiary Register on the Participant Portal and subject to a 

rigorous validation process that may last several weeks.  

Ideally, a LEAR is identified to be responsible for provision and maintenance of the Participant's legal and 

financial data. However, until a LEAR is identified and validated, this data may be maintained by the person 

who initially registered the organisation. 

Also named 'Proposal Project Participant' 

A "participant" is a legal entity taking part in an indirect action (i.e. a specific FP7 project 

undertaken by one or more participants) and having the rights and obligations defined by the 

Grant Agreement entered into with the European Commission (on behalf of the European 

Union). [from the Guide to Intellectual Property Rules for FP7 projects v.3)] 

http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
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Partner 
Individuals and legal entities such as companies, consortia, universities, university departments, etc. are 
allowed to submit proposals requesting financial support. The 'Partner' assists the Proposal Coordinator in 
preparing the proposal.  
To avoid the existing confusion, a difference is made between a Partner Contact and a Partner Organisation. 
The Partner Contact is either an individual or empowered individual of an organisation having the 
responsibility to assist the Proposal Coordinator in the submission of a proposal.  
The Partner Organisation is the organisation to which the Partner Contact belongs or is linked to, and/or that 
has given the Partner Contact the responsibility to assist in the preparation of a proposal. 
Any company, university, research centre, organisation or individual, legally established in any country, who 
participates in a collaborative project (known as an indirect action) provided that the minimum conditions laid 
down in the rules for participation in a research programme have been met, including any additional conditions 
laid down by specific programmes or individual work programmes. E.g., Beneficiary, 3rd party, researcher, 
principal investigator (for ERC projects) 

 

Participant Identification 

Code 

PIC 

The Participant Identification Code (PIC) is a 9-digit unique identifier for every validated organisation. 

Participants will not have to submit their legal and financial information (and supporting documents) each time 

they submit a proposal or negotiate a grant agreement, but just their PIC. 

Participant Portal 

PP 

The Research and Innovation Participant Portal is the single entry point for interaction with the research 

Directorates-General of the European Commission, it hosts a full range of services that facilitate the 

monitoring and the management of proposals and projects throughout their lifecycle, including calls for 

proposals, and access to the submission and evaluation of proposals service. 

 

If you want to participate in a project proposal, your organisation needs to be registered with the Commission. 

Registration is available from the Participant Portal Beneficiary Register page where you can check if your 

organisation is already registered; if not, you can start the registration process on the same page and you will 

be redirected to the Beneficiary Register to complete the process. The same process applies for beneficiary 

registration data updates – you access your organisation from the Participant Portal My Organisations page 

and from there you can go to the Beneficiary Register to update your organisation data. 

 

If your proposal is successful, you will also need to know about the following (see the H2020 Online Manual 

available from the Participant Portal): 

 the checks carried out on the information you provide on registering 

 appointing a representative (LEAR) 

 the checks that may be carried out on your organisation's financial viability 

Project start date The relevant provisions of the Grant Agreement determine the start date of the project. This may be the first 

day of the month following the entry into force of the Grant Agreement, a specific fixed date as negotiated or a 

date to be notified by the coordinator within [x] months from entry into force of the Grant Agreement. Where 

the Consortium requires a specific fixed start date for the project that precedes the entry into force of the Grant 

Agreement, full details regarding the justification for the request should be given in writing to the Project 

Officer prior to the finalisation of Annex I to the Grant Agreement and of the GPFs. The Commission/REA may 

refuse this request if no sufficient and acceptable justification is provided. 

Costs can be incurred from the start date of the project but not before. Where the start date of 

the project precedes the entry into force of the Grant Agreement, future beneficiaries take the 

risk that the Grant Agreement might not be signed. In such a case, costs will not be 

reimbursed by the Commission/REA. 

Proposal 
A set of documents submitted by third-parties in response to a particular call, in an effort to get funded by the 
EC after evaluation.  
The main elements of a proposal are the administrative forms and the proposal text. 

Proposal is a proposed project. 

Proposals are submitted following a call for proposals by consortium/partners with the goal to be selected and 

funded by the Commission. 

 

Proposal  

In order to get EC funding for a project, applicants have to write a complete and detailed proposal describing 

http://ec.europa.eu/research/participants/portal/desktop/en/organisations/register.html
http://ec.europa.eu/research/participants/docs/h2020-funding-guide/index_en.htm
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the objectives, planned activities and relevance with the corresponding Call's Activity(-ies). Proposals are 

individually evaluated by a team of independent experts. Only the very best project proposals will get funding. 

 

A description of the planned research activities, information on who will carry them out, how much they will 

cost, and how much funding is requested"  

Proposal Coordinator 
Individuals and legal entities such as companies, consortia, universities, university departments, etc. are 
allowed to submit proposals requesting financial support. The 'Proposal Coordinator' leads the submission 
process of the proposal and is the only applicant recognised by the Commission.  
To avoid the existing confusion, a difference is made between a Proposal Coordinator Contact and a Proposal 
Coordinator Organisation. 
The Proposal Coordinator Contact is either an individual or empowered individual of an organisation having 
the responsibility to request financial support via the submission of a proposal.  
The Proposal Coordinator Organisation is the organisation to which the Proposal Coordinator Contact belongs 
or is linked to, and/or that has given the Proposal Coordinator Contact the responsibility to submit a proposal 
to request financial support. 
 
The coordinator is a specific role of a beneficiary. 
The coordinator is the main driver and responsible for the project and normally it is the one communicating 
directly with the Commission. 
The coordinator submits the periodic reports and requests for amendments. 
It is usually the beneficiary responsible for redistributing the funds among further beneficiaries participating in 
a common project. 
 
Also named 'Proposal Project Coordinator' 

Broader Term: Beneficiary, Partner 

 

Proposal ID  An identifier assigned to a proposal after it was submitted. Once a proposal is funded, its Proposal ID 

becomes its Project ID  

REA Research Executive Agency 

Security aspect letter 

SAL 

Security Aspects Letter (SAL)’: “a set of special contractual conditions, issued by the contracting 

authority, which forms an integral part of a classified contract involving access to or generation of EU 

classified information, and that identifies the security requirements or those elements of the classified 

contract requiring security protection”, as defined in section 27 of Commission Decision 2001/844/EC, 

ECSC, Euratom. 

 

In the case of a proposal involving classified information (background and/or foreground), a Security Aspect 

Letter (SAL) and its annexed Security Classification Guide (SCG) must be part of the proposal. 

Security classification 

guide 

SCG 

The SCG will cover: 

– The level of classification of background and foreground; 

– Which participant will have access to what information; 

In addition, the following documents will be requested: 

– A copy of the Facility Security Clearances (FSC) (or the FSC requests). The validity 

of the FSC will be checked by the European Commission' Security Directorate 

through the appropriate formal channel with the National Security Authorities 

(NSAs) involved; 

– Formal written authorization by the relevant security authorities to use the classified 

background; 

Security considerations Security issues may be an important component of the research proposal evaluation procedure, especially in 

the FP7 Security Topic. All proposals received by the Commission/REA should clearly describe the security 

issues raised by the proposal, if any, and how they will be addressed in order to be in conformity with national, 

European and international regulations. For further references see Appendix 4 in negotiation guidelines. 

 

Synonym: security issues 

Security considerations A security-sensitive RTD action is an action that may need to handle classified information. 

A "security considerations" flag will be associated with a proposal: 
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flag • when the applicant declares a proposal as sensitive; 

• if the expert evaluators, the Commission, or members of the relevant "Programme 

Committee" (except for the Security Topic) detect or suspect any of the following conditions: 

– Classified information is, or may be, used as background information 

– Some foreground is planned to be classified 

Whenever a "security considerations" flag is associated with a proposal, the circumstances of the planned 

work will be further scrutinised according to the procedures for security scrutiny. 

Security scrutiny Special procedures will apply to security-related research, due to the sensitive nature of the subjects 

addressed, and the particular capability gaps that need to be addressed to protect Europe’s citizens. RTD 

actions will be classified if they are considered as sensitive. 

These procedures will apply to all RTD actions under the theme 'Security' in the Specific Programme 'Co-

operation'. They apply to other themes if so specified in the relevant call. 

Special clause (SC) A special clause is inserted in the Grant Agreement and is applicable where required. 

Stage 
A sequence of a submission and an evaluation procedure.  

A call for proposals can follow a one-stage or two-stage procedure.  

For one-stage calls, proposals are directly evaluated after being submitted. 

For two-stage calls, the proposal coordinator submits a short proposal that is evaluated; successful proposals 
are invited to submit a full proposal. The number of stages in the procedure and the type of proposal that is to 
be expected for each stage are configurable items. 

 

Step A round in the evaluation procedure. The evaluation of a proposal might be performed in one or two (or even 

more) steps. A first evaluation step may be based on a limited set of evaluation criteria, while another 

subsequent step may be based on the remaining evaluation criteria. 

Submission The formal act to submit a proposal to the Commission via a web based application. Proposals can be 

modified and submitted several times as long as the call has not been closed. After call closure the 

submission is prohibited and proposals are locked. Eligible proposals are thereafter made available to the 

evaluation system. 

SEP IT System The Participant Portal Proposal Submission and Evaluation System. 

Types of Action Horizon 2020 calls can have different types of action (funding schemes). 

The type of action specifies: 

 the scope of what is funded 

 the reimbursement rate 

 specific evaluation criteria to qualify for funding 

See the H2020 Online Manual for more information. 

 

http://ec.europa.eu/research/participants/docs/h2020-funding-guide/grants/applying-for-funding/find-a-call/what-you-need-to-know_en.htm

